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New interface design
The most immediately noticeable difference in Photoshop 
CS3 is the new interface design, which is part of a wider 
strategy to give all the applications in the CS3 creative suite 
a more unified look and therefore make the interfaces more 
consistent when switching between applications. 
	 To start with you will notice how the tools palette is 
presented in a single column. Now that we are all using 
bigger displays, there is no real need for the old two 
column version. You will also notice that the palette well 
has disappeared from the tool options bar. The palettes 
can now be displayed on the left or right hand side of the 
screen grouped into multiple column docking zones and 
easily hidden or made visible by rolling the mouse to either 

Figure 1 The Photoshop CS3 Windows PC layout.

Pen path appearance
The path outlines that are created when 
you use the pen tool have now been made 
slightly bolder and are easier to see on 
the display. The same also applies when 
drawing a freehand selection using the 
lasso tool.
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Figure 2 The new Photoshop CS3 Mac OS X layout. In this screenshot the Layers, 
Channels and Paths palettes were placed in a third column docking zone. You can 
see here that if I click on a palette icon, this will quickly expand to reveal the normal 
full size palette. 

side of the screen. The main intention here has been to 
create the most efficient use of screen space when working 
with the palettes and image documents. Palette docking is 
easier to accomplish and in the Windows layout in Figure1 
you can see how the palettes in the second column from 
the right have been compressed into tabbed palette mode. 
All palettes can now be collapsed in this way so that the 
palettes are represented as icons that graphically indicate 
the identity of each palette. To collapse a palette docking 
zone, you just click on the double arrow button at the top of 
each palette zone and click again to expand the palettes.

Figure 3 Don’t like the single row palette? 
Well, a click on the double arrow icon in the 
palette tab will allow you to toggle between the 
single and double row versions of the tools 
palette. 
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Figure 4 The Photoshop installer procedure will be more or less identical on 
both Mac and PC systems. As you complete the installation process and are about 
to start using the program you will be requested to complete a registration form 
like the one shown above.

Adobe Photoshop activation
You can load Photoshop on any number 
of computers, but only a maximum of 
two installations can be active at any one 
time. To use any two different machines 
will involve de-activation and re-activation 
only, but not a complete install.

Photoshop installation
Installing Photoshop is as easy as installing any other 
application on your computer. But make sure that your web 
browser and any other Adobe programs are closed prior to 
running the installation setup. After completing your user 
information and serial number details, you will be faced 
with a Product Activation option. This has to be selected 
in order to activate Photoshop. And the reason it is there 
is to limit unauthorized distribution of the program. The 
standard license entitles you to use Photoshop on up to two 
computers, but not both at once.

The Photoshop interface
Photoshop CS3 now has a brand new interface which is 
in keeping with planned integration of all the CS3 suite 
interface designs. Basically this can make it easier to 
migrate from using one CS3 program and another when 
there is a greater level of consistency in the interface 
design. In Figure 5 you can see the default Photoshop 
layout in which the Photoshop palettes are held in 
placement zones with the tools palette on the left, the 
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Figure 5 This is the Photoshop CS3 interface showing the default layout for all 
the palettes. The Options bar is normally positioned at the top of the screen just 
below the menu bar, but you can also position it at the bottom or even on a second 
monitor, along with all the other palettes.

Options palette running across the top of the screen and 
all other remaining palettes arranged on the right hand 
side of the screen, where they can be docked in various 
ways to economize on the use of screen space, yet remain 
easily accessible. The default arrangement will present 
the palettes in a docked mode and over the following few 
pages we shall look at ways to customize the layout of the 
interface. For example, you can economize on the space 
taken up by the palettes by collapsing them into compact 
palette icons.
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Figure 6 Where tools are marked with a 
triangle in the bottom right corner, if you mouse 
down on the tool you will see all the other tools 
that are nested in that particular group.

Photoshop CS3 tools palette
The Tools palette layout contains 60 separate tools. 
Double-clicking any tool will automatically display the 
Tool options palette (if it happens to be hidden) and from 
there you can select individual options for that tool.
	 Many of the tools listed in the tools palette have a 
triangle in the bottom right corner of the tool icon, which 
indicates that there are extra tools nested in a tool group.
If you mouse down on the tool icon, this will reveal the list 
of tools (see figure 6) and you can click on any of the tools 
in the list to make it the new default tool for that group.
	 You will notice that each tool or set of tools will 
have an associated keyboard shortcut. This is displayed 
whenever you mouse down to reveal the nested tools or 
hover with the cursor to reveal the tool tip info, and you 
can use these to quickly select a tool without having to 
always use the tools palette to select the tool you wish 
to use. For example, pressing c on the keyboard will 
activate the crop tool and pressing j will select whichever 
of the healing brush group of tools is currently selected in 
the tools palette. Where more than one tool shares the same 
keyboard shortcut, you can cycle through these other tools 
by holding down the S key as you press the keyboard 
shortcut. But if you prefer to restore the old behavior 
whereby repeated pressing of the key would cycle the tool 
selection, go to the Photoshop menu, select Preferences 
➯ General and deselect the Use Shift Key for Tool Switch 
option (personally, I prefer using the shift key method). You 
can also O A-click the tool icon in the Tools palette to 
cycle through the grouped tools.
	 There are specific situations when Photoshop will 
not allow you to use certain tools and display a prohibit 
sign ( ). For example, you might be editing an image in 
32-bit mode where only some tools can be used to edit the 
image. Clicking once in the image document window will 
call up a dialog explaining the exact reason why you cannot 
access or use a particular tool. 

Adobe On-line
Any late-breaking information plus access 
to on-line help and professional tips are all 
easily accessible within Photoshop. If you 
click on the PS icon in the Tools palette, 
this will open the Adobe On-line... dialog 
(which is also available in the Help menu). 
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Figure 7 The Tools palette with keyboard shortcuts shown in brackets. Note that the 
count tool is only available in the extended version of Photoshop CS3.

Move tool (V)

Quick selection/Magic wand (W)

Brush tool/Pencil/Color replacement tool (B)

Eyedropper/Color sampler/Measure/Count* (I)

Zoom tool (Z)

Spot Healing brush/Healing brush/Patch tool/Red eye tool (J)

Eraser/Background/Magic Eraser (E)

Clone Stamp/Pattern Stamp (S)

Hand tool (H)

Lasso tools (L)

Marquee selection tools (M)

Background color

Exchange colors (X)

Foreground color

Default colors 
setting (D)

Standard display/Quickmask display mode (Q)

Screen display modes (F)

History/Art History brush (Y)

Blur/Sharpen/Smudge (R)

Adobe On-line

Pen path tools (P)

Crop tool (C)

Type tools/Type mask tools (T)

Dodge/Burn/Sponge (O)

Gradients/Paint Bucket (G)

Slice/Slice select tool (K)

Annotation tools (N)

Path Selection/Direct Selection (A)

Shape tools (U)
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Figure 9 Photoshop palettes can be collapsed 
by clicking on the minus button (Mac) or 
minimize/maximize button (PC). The Mac button 
is shown circled above. Clicking this button once 
will collapse the palette to shrink to the most 
compact size, according to the number of items 
present (middle). Clicking again or double-
clicking the palette tab will collapse the palette to 
display the palette tab only (bottom).

Figure 8 To group palettes, mouse down on the palette tab and with the mouse 
held down, drag the tab across to another palette or group of palettes and release the 
mouse once it is inside the other palettes. To remove a palette from a group, mouse 
down on the palette tab and drag outside the palette group.

Figure 10 When palettes are docked you can 
adjust the width of all the palettes at once by 
dragging anywhere along the side edge of the 
palettes.

The Photoshop palettes
The Photoshop palettes can be positioned almost anywhere 
on the screen, but the intention in Photoshop CS3 is for the 
palettes to reside in a docked layout where the palettes are 
grouped into column zone areas.
	 You can position the individual palettes by mousing 
down on the palette title bar (or palette icon) and dragging 
them to a new location. A single click on the minus icon 
( ) in the palette, or indeed anywhere on the palette tab, 
will collapse a palette into compact mode and clicking on 
the button or the tab will expand the palette view again. 
You can also adjust the height and width of a palette by 
dragging the size box in the bottom right corner.
	 As is shown in Figure 8, palettes can be grouped by 
mousing down on a palette tab and dragging it across to 
another palette. When palettes are grouped this way they 
are like folders in a file cabinet, just click on a tab to bring 
that palette to the front of the group. To separate a palette 
from a group, mouse down on the palette tab and drag it 
outside of the palette group again.

Palette docking
The default Photoshop workspace will arrange the palettes 
in a docked layout a bit like the way the palettes are shown 
in Figure10, but with the Paths/Layers/Channels palette 
group expanded to fill the height of the screen.
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Figure 12 As you reposition a palette and 
prepare to dock it inside or to the edges of the 
other palettes, a thick blue line will indicate that 
when you release the mouse, this is where the 
palette will attach itself.

Figure 11 Photoshop palettes can be grouped into columns. When an image 
document is viewed in full screen mode, the document will fill the screen up to the 
edge of the palette column zone area. You can adjust the width of a palette column by 
dragging on the bar in the column header and switch from palette icon mode to full 
palette mode by clicking on the double-arrow button (circled).

	 In Figure 11 I have shown how the palette columns will 
appear when an image document is displayed in maximized 
screen mode. In this example, the image document will fill 
the horizontal space between the tools palette on the left 
and the palette columns on the right. I have also shown 
how you can mouse down on the column bar in the palette 
header to adjust the column width and highlighted the 
double-arrow button, which can be used to switch between 
the icon and full palette modes. As you increase the width 
of a column, the palette contents will expand and you will 
get to see the names of the palettes appear next to the icons.
	 You can rearrange the palette layout by pulling palettes 
out from a column and placing them anywhere you like on 
the screen, or drag them to a new position, by attaching a 
palette at the bottom of a column, in the middle, or place 
it alongside an existing column to create a new palette 
column. As you do so, a thick blue line will appear along 
the edge of the column to indicate that if you release the 
mouse, this is where the palette will attach itself.
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Workspace settings
If you are searching for a particular palette and can’t find 
it, the palette may just be hidden. Go to the Window menu 
and select the palette name from the menu. The Ê key 
(also indicated as T) shortcut will toggle hiding and 
showing all the palettes. ÊS will toggle hiding/
showing all the currently visible palettes except the Tools 
palette and options bar. This is useful to remember if all 
your palettes seem to have disappeared. Try pressing Ê 
and you should be able to view them once again.
	 If at any time you wish to restore the palette positions, 
go to the Window ➯ Workspace menu and select 
Reset Palette Locations. You can also save the current 
palette arrangement as a custom workspace by going 
to the Window menu and choosing Workspace ➯ Save 
Workspace... A dialog box will pop up that will ask you to 
name the workspace and save it. The next time you visit 
the Window ➯ Workspace menu you will see the saved 
work space appear in the menu listing. This is a real handy 
feature that can enable you to switch quickly between 
different custom palette arrangements.
	 If you want to be extra clever, you can go to the Edit 
➯ Keyboard Shortcuts menu and choose Shortcuts for 
Application menus: Windows. Scroll down and you will 
see a list of all the currently saved Workspace presets. You 
can now assign keyboard shortcuts that will allow you to 
jump quickly from one workspace setting to another.
	  If you have a second monitor display, you can arrange 
for all the palettes to be displayed nestled on the second 
screen, leaving the main monitor clear to display the whole 
image.
	 With Photoshop you can save more than just the palette 
positions though. You can create custom keyboard shortcuts 
and customize the layout and coloring of the menu items. 
You will note that the Save Workspace dialog allows you 
to include these items in the saved workspace setting 
and you will note that there are also a number of preset 
Workspace options that are available for you to try out in 
the Workspace submenu.

Figure 13 The Save Workspace menu in 
Photoshop can be used to save custom palette 
work space setups. These can be recalled by 
revisiting the menu and highlighting the work 
space name. To remove a work space, choose 
Delete Workspace... from the menu.

Options palette workspace menu
You can also quickly access saved 
workspaces via the Workspace menu in the 
Options palette.


